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An overview of the basic concepts  
to understand and use the Advanced 
Database Gateway (ADG)
 
 
The Advanced Database Gateway (ADG) is a software produced by FAO-GLCN that allows users to better understand 
and interact with land cover databases built up using the LCML (LCCS3) logic.

The new FAO Land Cover Meta Language (LCML) improves and expands the idea that was developed in the design 
of previous versions 1 and 2 of the FAO LCCS that it is more important to standardize the attribute terminology rather 
than the final categories themselves. LCML and its derived application software LCCS3 is an innovative “object oriented” 
meta-language that specifies a new perspective for the semantic representation of land features. The characterization of 
land features is defined by a combination of well-defined “basic objects” that can be optionally linked with a series of 
different attributes.  An extensive UML schema describes the relationships, rules and conditions governing the objects and 
their attributes.  The overall approach is fully compatible with advances in modelling and computer language assuring the 
migration toward modern and dynamic management of geographic data.  It is important to enable end users to correctly 
interact with such types of databases, in order to fully benefit from its innovative aspects. 

The ADG has two main basic functions:

 • decoding and analysis: each database category is decoded and analyzed according to the LCML rules. The end 
user can understand both objects (and their attributes) and rules/conditions that the “map producer” has utilized 
to formalize the meaning of each category of the legend;

 • customized querying by objects: using the capability of the software to automatically understand the class content, 
the user can query the database in an innovative way. Instead of the usual query by “class name” the user can 
determine “user defined” objects and rules with which to interrogate the database. This approach bypasses the 
ambiguity related to different understandings of the meaning of the different class names and allows the end 
user to interrogate the database more effectively according to their specific needs. This will ensure that there is no 
data redundancy, no conflict of definitions, transparency and deep understanding of the classification criteria and 
reusability.
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OVERVIEW: THE MAIN 
 WINDOW SHELF

This chapter gives a general overview of the structure of the main window shelf (see Fig.1).  Each  function symbolized in 
the different “tools bars” and interface window buttons is fully explained/documented, including the loading of a specific 
database and related legend, which would be the user’s first interaction with the software. The subsequent chapters will 
illustrate step by step the functions present in the different modules of the software which are called “Phase 1, 2, 3 and 4”.
The sequence and meaning of each “Phase” is explained below (chapter 1.1).

1.1 - The main toolbar

The main tool bar contains the File menu, the Phases menu, the View menu and the Help menu. 
 • The “File” menu contains the commands to open a new file “new” or to open an existing file “open” and a series of 

additional commands to “copy” and “print” existing files.
 • The “Phases” menu controls the loading of one of the 4 different “Phases” through which the user can interact and 

work with the loaded database, they are listed below:
1. “Selection”: menu where the user can perform different types of selections of the database;
2. “Check Up”: menu where the user can visualize the database in different modes, visualize the legend both 

in graphical and textual form, analyze the “scale adequacy” of each single class and a report of the LCML 
“elements” populating the legend classes;

3. “Analysis”: menu where the user can analyze the legend graph and create their “user defined” classes with which 
to interrogate the database. In addition the menu contains commands to save “dissolved” or “undissolved” 
polygons (refer to Chapter 4);

4. “Application”: menu containing some applications based on the use of LCML elements.

1.2 - The main data window

The main data window is the area where 
the loaded database is displayed. In 
addition to the selected polygons the user 
can add and visualize extra polygon layers 
or extra polylines as road, river network 
or administrative boundaries. By default 3 
types of legend can be applied to the map 
based on the LCCS codes:

 • legend on Polygon Codes; 
 • legend on Classes; 
 • legend on Major LC Type.

Legend on Polygon Codes
Each polygon code is represented with a different color. It is the 
maximum legend detail that can be observed in the displayed map. 
Any combination of single and mixed units is represented in the map 
and in the graph as a single color representation.

Legend on Classes
The area covered by each class is calculated as the result of 
single and mixed units (see class details below). The polygon is 
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Fig.1	 -	Main window shelf.
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represented, in mixed units, with the 
color of the first class code. See chapter 6 
for more information on the Mixed unit 
concept.

Legend on Major LC Type 
The polygons are grouped according to 
the major LCML/LCCS3 Elements 
(Biotic and Abiotic). See chapter 3 for 
more information.

1.3 - The navigation toolbar

The navigation toolbar contains the routine commands for zooming and roaming the displayed data. In addition the 
“information” command allows the user to display the LCML derived class graph for each selected polygon.

1.4 - The preview panel

The preview panel allows the user to have a customized overview of the data displayed in the “main data window”. Each 
class present in the database is displayed with a specific graphic bar; clicking on the bar highlights the corresponding 
polygons containing the selected class in the database.  In addition, a “flag” will show additional class information such as 
class name (label), map code, total area occupied by the class and total number of polygons labeled with the selected class. 
The general display of the class bars can be customized with specifics parameters: see Fig.2 below.

1.5 - The status bar

The status bar displays the cursor coordinates and the display scale of the database.
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Bars are sorted according to class name (N) or to class value (V)

Bars are sorted according to polygon number (#) or area (A)

Commands to decrease or increase the size of the bars

Bars are sorted in ascending and descending mode 

Fig.2	 -	The preview panel.
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1.6 - Display map features 

In this paragraph all steps to load a database are 
explained. They can be divided into two major 
actions:

Action 1 - Loading of map features. 
1. Click the Open button          on the 

Standard toolbar (or choose from the 
menu File\Open\). 

2. Double Click on the selected file.

Action 2 - Loading of LCCS attributes and LCCS3 legend. Define the table fields (containing the LCCS code, modifiers 
and user label) and the legend. In the dropdown menus choose:

1. “LCS3code” in the field “Attribute containing LCCS3 Map Code”. 
2. “LCS3mods” in the field “Attribute containing LCCS3 Modifiers”.
3. “LCS3uslb” in the field “Attribute containing User label”.
4. “Load the legend” in the field “Select LCCS3 legend”.

The following additional options are available: 
A. “Exclude from reading”: all the other attributes, if not needed, will be excluded.
B. “Optional Proportion value”: this function has been set up to calculate the surface area of a specific ADG class 

when a geographic area is mapped by sample areas. With these functions the user can enable ADG to consider 
(and calculate) the “proportion” between different types of samples. If for example a country has been mapped 
with two different sample types (first one using a 1 by 1 degree sampling density and the second using a ½ by 
½ degree sampling density), if the proportion between the two has been reported in an appropriate shape file, 
ADG can make a total area estimation of each ADG class, considering (and calculating) their origin as one 
of the two samples types.

1.7 - The phase function list

This section allows the selection/activation of the different phases that constitute the core structure of the software. The 
different phases and their different functions are listed in the following chapters. 

1.

2.

3.

4.

1.

2.

3.

A.

B.
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OVERVIEW: FUNCTIONALITIES  
OF THE “SELECTION” MODULE 
(PHASE 1)

In this “function tree” you will find all the tools that will enable the selection of the database polygons according to the 
user’s needs. Five selection types exist:

When a selection is made one of the 4 additional options can be selected:

Note that the command “accept selection” should be only used at the end of the selection process.

2
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Selection of all polygons of the database.

Select polygons with the mouse pointer by clicking them one at a time.

Select polygons by clicking and dragging a box around them.

Select polygons by clicking and dragging a user defined polygon around them, (to complete the 
polygon, click the right mouse button).

The popup windows “select polygons shapefile to use for selection” allow the user to browse to the 
location and load a file (administrative boundaries for instance) that will be the geographic reference 
of the selection (all the polygons that intersect the shapefile will be selected).

Unselect previously
selected polygons.

Accept selection.
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OVERVIEW: FUNCTIONALITIES
OF THE “CHECK UP” MODULE 
(PHASE 2)

In this “function list” you will find all the tools that will enable the analysis of the database content and structure. Seven 
function utilities exist:
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As explained in chapter 1.2 this function (duplicated in the “Main tool bar”) allows users to visualize 
the database according to the polygon codes. It is the maximum amount of legend detail that can be 
applied to the displayed map. With this option, all the polygons coded with “single” or “mixed” coding 
will be shown in the display map with a different color. To better understand the difference between 
“polygon codes” and “class codes” refer to chapter 1 par.1.2 and chapter 6 “Basic Concepts”. 

As explained in chapter 1.2 this function (duplicated in the “Main tool bar”) allows the user to 
visualize the database according to the main class code. In case of a polygon with a mixed code 
(formed by two or more classes of the original legend) it will be represented with the color assigned 
to the dominant class (the first in the sequence A/B). To better understand the meaning of “single” 
and “mixed” refer to chapter 6. “Basic Concepts”.

As explained in chapter 1.2 this function (duplicated in the “Main tool bar” allows the user to visualize 
the database according to the major LCML/LCCS3 elements (Biotic and Abiotic) populating the 
class. To better understand the meaning of the LCML/LCCS3 Elements refer to the LCCS3 manual 
or to the brief LCML introduction in chapter.

This function allows the user to visualize the full list of classes (legend) present in the database. 
The legend classes are visualized both in text and graphical format (see Fig.3 and Fig.4 below).

This function gives an overview of the database structure according to the FAO “Cartographic 
Standards” (see chapter 6). The report list for each class of the database: the total number of 
polygons coded (with the given class code), the number of polygons where the given class was the 
only one coded (single class), the number of polygons where the given class was combined in a 
“mixed coding” with other classes (as first, second or third sequence). See Fig.5 below.

This function allows the user to recognize if the database is sufficiently detailed (scale or Minimum 
Mapping Unit value, see page 38) to correctly represent a specific land feature (represented in the 
database by a specific legend class). If the database has been built according to the FAO/GLCN 
cartographic standards (see chapter 6.) the ratio between the amount of polygons where a specific 
class has been represented with a “single” code and the amount of polygons where the same class 
has been coded with a “mixed coding” can give a measure of whether the level of detail of the 
database is “adequate” (or sufficient) to represent a specific land feature. When a database is fully 
exhaustive the specific selected class will be always represented with a single coding, the resulting 
“scale adequacy” value will be, therefore equal to 1. If, in some situations, the selected class (due to 
its geographic dimensions) cannot be fully represented with a “single coding” but is “generalized” 
with a “mixed coding” the resulting “scale adequacy” will be less than 1. The discordance from the 
reference value 1 (a specific land feature always represented with a single coding) will therefore 
determine how much the selected class has been “generalized” in the database. In addition the 
table (see Fig.6) shows additional class information: count of the number of polygons coded with 
the specific class (as “single” or “mixed” coding), area, polygon frequency, extension ( % of selected 
polygons over total area).

This function allows the user to list all LCML Elements (including their properties and characteristics) 
used to build up the thematic content of the database (legend). Note these are not classes but the 
language (LCML) elements used to create them (see chapter 6).

3
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Note: some of the functions listed in this “functions tree” are peculiar for databases adopting the FAO/GLCN cartographic 
standards. If a database does not apply these standards (for instance “mixed coding” procedures) some of the listed functions 
will always show the same result, in particular:

 • if no mixed coding is used, the function 1 (legend shown by polygon codes) and 2 (legend shown by polygon 
classes) as explained in chapter 3 will not show any difference;

 • following the same logic, function 6 (list of polygon codes and scale adequacy) as explained in chapter 3 for the 
part regarding the “scale adequacy” will not show any value variation (being all the values of the scale adequacy 
set to 1). 

Fig.3	 - Legend report in text format.

Fig.4	 -	Legend report in graphical format.
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Fig.6	 -	List of polygons codes and scale 
adequacy report.

Fig.7	 -	LCML elements report.
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Fig.5	 -	List of single thematic classes.
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OVERVIEW: FUNCTIONALITIES
OF THE “ANALYSIS” MODULE 
(PHASE 3)

This module lists all the tools that will enable the analysis of the database, the generation of  “user defined” ADG classes 
to query the database content and structure,  and the commands and options to save the results. Six functions exist:
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4
This command activates the “ADG class editing“ window (see Fig.8). The window contains all 
the graphic information to understand the meaning of each classes of the original legend and a 
dedicated window “ADG class” where user defined classes can be created. A detailed overview of 
the tools and functions of this window will be given in chapter 5.

When the “ADG user defined” classes are created the “ADG classes” function opens a window to 
visualize and edit them (Fig.9). 

This function relates the “ADG user defined” classes to the original database and displays the 
results. When activating the function a window appears (see Fig.10), this window allows the user 
to decide in which modality they want to apply the current ADG legend to the original polygons (as 
said in the previous chapter for other ADG functionalities, this function pertains to databases 
structured according to the FAO-GLCN cartographic standards). Let’s assume the original legend 
is composed of classes 1, 2, 3 and 4; and two ADG classes are created called A and B (where 
A combines classes 1 and 3 and B combines original classes 2 and 4), and that in the original 
database the FAOGLCN mixed coding is present (for instance 1/2). When using the first option 
“Assign a single ADG class to the whole Polygon Code” the resulting ADG class will be A (the 
system considers always the first class of the mixed coding) while in the second case “Assign an 
ADG class to every Class Code in the Polygon Code” the resulting ADG class will be A/B. 

When one of the two options shown in Fig.10 has been chosen, clicking the OK button the resulting 
aggregated database will show (Figs. 11-12).

This function shows a report of the total number of polygons and relative area for each ADG class 
(see Fig.13).

This function allows the user to save the original polygons dissolved according to the same ADG 
class (the boundaries between the same ADG class are merged).

This function allows the user to save the original polygons coded with the new ADG class 
undissolved, therefore maintaining their original boundaries.
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Fig.9	 -	Window to visualize and edit current ADG classes.

Fig.10	 -	Commands to select with which modalities the current ADG legend classes (user 
defined classes) will be applied to the original database.

Fig.8	 -	ADG class editing shelf.
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Fig.11	 -	Original Database.

Fig.12	 -	Database aggregated according to the ADG classes.

Fig.13	 -	ADG classes consistency report.
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AN ADG LEGEND

This chapter explains how to create ADG classes as tools to interrogate the database previously loaded and visualized 
in the ADG main window. The whole procedure is divided into four different steps for an easier understanding of the 
different functions present in the “ADG editing“ shelf.

5.1 - Step 1 

Activating the “LCCS graph analysis” button                      in Phase 3 opens the ADG editing shelf (see Fig.14). The ADG 
editing window contains 4 different shelves:

1. LCCS3 legend: shelf where all the classes of the database legend are displayed;
2. LCML language elements: shows all LCML Elements (Basic objects and their Characteristics) present in the 

classes of the legend;
3. Class Hierarchy: shows the re-organization of the legend classes according to the major differentiating criteria 

of LCML;
4. ADG Class: shelf for creation of customized classes.

5.2 - Step 2

The user makes a detailed analysis of the thematic content of the legend. Because LCML is an “object oriented” system 
the analysis is done by LCML Element (and/or their characteristics). The example below shows how to understand the 
presence of the LCML Element “trees” in the legend. Shelves 1, 2 and 3 are linked i.e. choosing an LCML Element in 
any of the three shelves will activate it also in the other two. 

5

1.

2.

2.

3.

Fig.14	 -	ADG editing window.
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If for instance the LCML Element ‘trees’ is selected in the LCML Language Elements shelf (see Fig.15) the user will see 
the following information:

 • in the same shelf: relationship of the selected LCML Element with other LCML Elements (in our case 
shrubs and Herbaceous growth form) and LCML characteristics linked to this specific LCML Element in 
the database (Fig.15);

 • in the LCCS3 Legend shelf:  all classes of the database containing the LCML Element trees in their semantic 
structure (see Fig.16); 

 • in the Class Hierarchy shelf: the re-organization of the classes shown at point 2 according to the LCML 
hierarchical structure (see Fig. 17).

Fig.15	 - The selected LCML Elements tree and its relationship with other LCML Elements and 
Characteristics linked t it in the database classes.

Fig.16	 -	Portion of the legend classes including the LCML Element trees in their semantic structure.
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5.3 - Step 3

When fully confident with the “semantic” structure of the database the user can start to create their own classes and query 
the database in an “object oriented” way. To perform this task the user has to work with the ADG class shelf (see Fig.18)
The shelf is composed of 5 different sections:

1. commands to edit, save or retrieve an ADG class or legend;
2. commands to zoom in or out the shelf;
3. list of the ADG classes;
4. interactive working area for the build-up of the classes and visualization of their components;
5. list of the existing mixed units in the database, their composition and the position of each class as dominant (first 

position) or sub-dominant (second or third position) according to the FAO/GLCM cartographic standards.

To start to create an ADG class the “New ADG Class” button must be activated, a specific box will appear in section 4 
(see Fig.19). Double-clicking inside the “ADG Class” box will cause an “ADG Class properties” window to open that will 
allow the user to define the class name and description. 

 

   

2.1.

3.

4.

5.

Fig.18	 -	ADG class shelf overview.

Fig.17	 -	Re-organization of the selected classes according to the LCML hierarchical structure.

Fig.19	 	-	ADG class properties shelf opened when activating a “New ADG class”.
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The creation of a user defined ADG class follows the same “object oriented” logic of LCML. The user must select the 
LCML Element(s) and their properties and characteristics by selecting the element in the legend shelf from one of the 
existing available legend classes, then right-clicking to insert the element into the new user defined ADG class (see Figs 
20-21). This action should be repeated until all the Elements (and characteristics) are correctly listed in the new ADG 
class and all the classes in the legend, according to the user’s needs. 

When an ADG class has been defined according to LCML Elements and Characteristics, they can be further characterized 
with specific “conditions” . To perform these actions follow the actions shown in Fig. 22. For example if the user wants to 
add to the Element ‘trees’ some extra conditions for the cover (a cover range between 10-40%):

Action 1: double click on the Element trees, a pop up window (in Fig.22 called A) will appear with the selected element.

Action 2: click on “add” to activate the pop up window (B) to select the property of interest of the element trees  (in our 
example “cover”).

Add new LCML element

Fig.20	 -	Selection of an LCML Element for the original legend list.

Fig.21	 -	The LCML element into the new ADG user defined class.
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Action 3: select the property from the list of the available properties for the selected element. Selecting the property will 
open another popup window (in our example C) where the user can select the chosen value range.

Action 4: determine the value range for which the extra condition must be activated.

Action 5: selecting the matching mode. When performing this action the system allows the user to choose between two 
options with which this particular condition will query the database:

 • Intersect: all the values of the property “cover” of the element “trees” in the database that intersect the selected 
range will be considered (for instance in the database a class may exist with the cover value of the element 
trees from 5 to 12 %. In this case even if there is a big difference between this range and the selected one, the 
corresponding class will be considered because one value of the range is enclosed – intersects - the selected range). 

 • Majority: in this case, to be selected, the original range values must have a portion of its range value for more than 
50% inside the selected range.

Action 6: defining/requiring the absence/presence of a specific LCML Element. This function is used to further refine 
specific query conditions. Example: in a database different types of tree-covered areas exist (terrestrial, freshwater and 
mangrove trees). If the scope of the user is to extract from this database only the areas with the presence of “terrestrial” 
trees the user must first create an ADG class with the Element trees (for this element the user must choose the default 
condition “Require presence”). As the condition element “water” must be added, for this element the option “require 
absence” must be set. These two presence/absence conditions will guide the system to correctly select only the classes 
containing the element tree only when it is terrestrial (no presence of the element ‘water’). 

When the ADG class is set up the corresponding polygons are highlighted in the database shown in the “main window” 
(see Fig. 23), the % value of the class both polygon number and for the surface area is shown in the “ADG class” shelf 
respectively with the symbol # and A (see the red arrow in Fig.21).

Fig.22	 -	An overview of the different popup windows  activated during the process of adding specific condition 
to the ADG user defined class.

Action 1.

Action 2.

Action 6.

A

B

C

Action 3.

Action 5.

Action 4.
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5.4 - Step 4

When the user defined ADG classes are defined, the last step before applying the ADG legend to the database is the 
verification/modification of how the software attributes the ADG classes to the original database categories.  Two actions 
are recommended:

1. determine for each ADG class the level of similarity to the original database category;
2. modify (when necessary) the order with which the ADG software determines the attribution criteria of the 

ADG classes to the original database categories.

Action 1: when an ADG class is activated the categories of the original legend are marked with different colored symbols 
(see Fig.24). The colors determine a rough degree of “similarity” of the legend classes with the selected ADG class as 
follows:

 • Green label: at least one layer of the legend class has a perfect match with the reference ADG class. Other layers 
(strata) can exist in the legend class, however they must be populated with LCML “basic objects” derived from the 
same LCML “major groups” Biotic or Abiotic.

 • Yellow label: the match is not perfect but at least all the conditions expressed in the reference ADG class are 
present at least in one strata of the legend class. In this case also, if more than one layer exists it must belong to the 
same LCML “major group” of the one with which the comparison has been considered.

 • Brown label: the match is not perfect:
1. one of the strata of the legend class matches the conditions of the reference ADG class but in the strata more 

attributes are present
2. and/or other strata with objects belonging to a different LCML “major group” are present 
3. and/or LCML “basic objects” with a different main characteristic (natural semi-natural versus cultivated and 

managed) are present. 
 • No label: the match is not present for the following reasons: 

1. None of the strata forming the legend class have an LCML “basic object” populating the reference ADG class.
2. Even in the case that the legend class contains the same LCML basic object, in the reference ADG class there 

are extra characteristics attached to the LCML basic object not present in the legend class (see Fig.25). 

Action 2: when the ADG classes are created, the system automatically (using predefined criteria) assigns to each original 
legend class a priority list. The list shows which ADG class the original legend classes will be re-coded to. The list can 

Fig.23	 -	The polygons of the original database corresponding to the ADG user defined class are shown in the main 
window map display.
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ADG Class matching

Fig.24	 -	Classes of the original legend compared to the “ADG user defined” class showing different types of matches.

Fig.25	 - Popup window with information about the class (red arrow).
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be seen holding the cursor over the selected legend class; in this case a box will appear with information about the class 
(class name, map code etc.). The last row in the box (ADG class matching) shows the order currently set (see Fig.25). It 
may be that this predefined order selection does not fit the needs of the user. In the example shown in Fig 25 the original 
legend class selected is an herbaceous cropland with some scattered natural trees. In this particular case the automatic 
pre-ordering of the software will privilege the presence of woody versus the herbaceous vegetation, therefore the order list 
will show first the ADG classes “Trees” and “Trees nat.” and only at the end the class “Herb.cult.” The user, however, has 
the possibility to manually modify this order with the following steps as shown in Fig 26:

1. double click on the ADG class box, a pop up window (A) will appear;
2. selecting “add” another pop up window will appear: “select one of the map codes” (B);
3. in this window the class to which to assign the “user defined” priority must be selected form the list of the 

original legend classes. If, for instance in the previous,  we want to modify the order of the match of the ADG 
classes with the original legend class Hc, the Hc code must be selected;

4. when the “OK” button is clicked the pop up window “ADG class properties”  (C) will show the original legend 
class code (in our case Hc) in the “list of LCCS map codes for which the ADG class has priority”;

5. when the “OK” button is clicked the new priority is set up and is shown in the ADG class box (as indicated in 
Fig.26) and in the information box (with a symbol + near the class with priority) as shown in Fig.27.

The rearrangement of the priority order of the ADG classes 
versus the original legend can be repeated until when the 
user is fully satisfied of the translation rules; at this point the 
database can be translated according to the new ADG classes 
and the results can be saved with the modality “dissolved” or 
“un-dissolved” as shown in chapter 4.

When all these actions are performed the user can use the 
rules of ADG user defined classes to properly interrogate 
the original database. As discussed in chapter 4 the user will 
apply the ADG legend (command: Apply ADG legend) to 
the original database choosing if the output must contain 
“dissolved” or “undissolved” polygons.

Action 1.

Action 2.

Action 3. A
B

C
Action 4.

Action 5.

Fig.26	 -	Sequence of commands to change the “matching” priority of the selected “ADG user class” with one of the 
existing original (Legend) classes of the database.

Fig.27	 -	Notification of the modification of the priority as explained in step 5 of Action 2.
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CREATE  
BASIC CONCEPTS

This section contains important information that is fundamental to proper use of the ADG software, especially for the 
databases applying the FAO/GLCM “cartographic standards:

 • LCML objects and characteristics, class, polygon codes, legend; 
 • cartographic standards.

6.1 - LCML objects and characteristics: class, polygon codes, legend - Definitions

According to the LCML approach, basic objects organized in different strata and enriched in their “semantic” meaning 
with properties and characteristics compose a CLASS. The Class names (user and/or LCCS derived names) and the 
map code are redundant information. The derived UML model (composed of LCML objects and their properties and 
characteristics) is the real reference for users to understand the information contained in the class and operate thematic 
aggregations. In the mapping process, the classes will be applied to label the polygon i.e. attributing a polygon code. The 
polygon code can match a class of the legend or, due to the cartographic rules applied in the interpretation, be composed 
of two or three classes.  More information on polygon codes and mixed units are available in the Cartographic standards 
help page.

6.2 - Legend

The legend represents the thematic content of a database. It is built as a list of all the land cover types identified and 
mapped in the area. The legend classes are a subset of the classes contained in LCCS applied to a specific geographic 
context with a given spatial scale/detail. It gives a global vision of the land cover features present (thematic content) but 
does not provide information on their cartographic representation. A number of elements compose the legend according 
to the LCCS coding capabilities:

 • class user name: class name assigned by the LCCS user. The function of the class user name is to provide a class 
name that can be easily understood;

 • map code: synthetic code used during the interpretation phase. It is built to facilitate class recognition. It is the 
code embedded inside each map polygon;

 • LCCS code: a unique class code automatically assigned by LCCS; it can be modified using the class user name;
 • class description: is a detailed description of the class taking into account the object used and their interrelationship 

in the class. 

6.3 - Cartographic standards 

Cartographic standards are all the rules used to represent complexity of the reality in form of a map (bi-dimensional way). 
They can be summarized in three main groups:
 
Scale of interpretation.
Representing the level of detail given (or a level of detail compared to a given scale). 

Geodetic Framework. 
Reference ellipsoid, Geodetic datum, Cartographic projection. 
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Cartographic representation of thematic information.
Cartographic representation of thematic information is a large set of rules used to represent the thematic content in a 
cartographic context that FAO/GLCM has fully standardized. Only the most important rules are listed below:

 • the Minimum Mappable Area (M.M.A.) is a concept applied by cartographers when addressing the smallest area 
that can be shown on a map. Historically, the cartographers determined one particular minimum size of area to 
be mapped; this was applied to all classes contained in the legend. The disadvantage of the method applied in this 
rigid way is that classes with a difference in importance would follow the same rules. FAO/GLCN has introduced 
the concept of Variable Minimal Mapping Area (V.M.M.A.) where the user can relate the size of the minimal 
mapping area to the major land cover groups of its LCCS legend and to all the classes belonging to them. This 
gives the map producer the possibility to clarify the level of detail each land feature will have in the database;

 
 • mixed or functional Mapping Units. In the classification system (general legend), all classes should be unique 

and no Mixed Mapping code should be considered, the representation of “scale dependent” heterogeneous areas  
should be  managed at database level.  LCCS offers the possibility of generating a mixed coding in two different 
modalities: 

1. the Spatial mixed coding is a concept related to the Minimum Mappable Area. When two features A and B 
are both too small to be mapped alone according to the M.M.A. concept, a polygon comprising the two can 
be traced and coded as mixed unit (A/B or B/A);

2. the syntax concept of Functional units is a different concept not related to the scale or MMA. When using 
this specific modelling rule the map producer states that, a specific “heterogeneous” area is a “functional unit” 
and will be always represented with this modality irrespective of a change of scale or MMA. The “functional 
unit” concept can be applied to specific “ecological” representation of land features (for instance “Brousse 
Tigree”) or representation of manmade artificial features (for instance the representation of a complex urban 
area formed by a combination of linear and nonlinear features such as roads and buildings). These particular 
situations are modelled in the LCML schema using a combination of different “horizontal” patterns. ADG is 
fully supporting this specific symbology.
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